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ABSTRACT  

The Accuracy-Configurable Approximate (ACA) 

Adder introduces a novel hardware design that 

addresses the growing demand for energy-efficient 

and high-performance computing in modern 

applications. Unlike traditional arithmetic units, 

which lack dynamic accuracy adjustment, the ACA 

Adder seamlessly integrates approximate and 

accurate computation modes with runtime 

configurability, enabling real-time adaptation to 

varying precision requirements. By leveraging a 

parameterized sub-adder architecture and an error 

detection and correction mechanism, the ACA Adder 

achieves a remarkable 97% pass rate in approximate 

mode while maintaining full accuracy in critical 

computations. Experimental validation using 

Gaussian Smoothing demonstrates the ACA Adder's 

practical efficacy. In approximate mode, the design 

achieves a Peak Signal-to-Noise Ratio (PSNR) of 

33.13 dB and a Structural Similarity Index (SSIM) of 

0.8611, delivering high-quality results with 

significant energy savings. In accurate mode, the 

ACA Adder achieves a PSNR of 39.90 dB and an 

SSIM of 0.9663, ensuring precision for critical 

computations. The design achieves up to 37% power 

savings and a 24.6% throughput improvement 

compared to conventional adders, making it an ideal 

solution for energy-constrained applications such as 

multimedia processing, signal processing, and 

embedded systems. By striking an optimal balance 

between performance, energy efficiency, and 

computational accuracy, the ACA Adder sets a new 

standard for next-generation integrated circuits, 

enabling smarter and more sustainable hardware 

designs.  

 

1-INTRODUCTION 

With the rapid advancement of data-driven 

applications such as multimedia processing, machine 

learning, and Internet of Things (IoT) devices, there 

has been a growing demand for energy-efficient and 

high-performance computing. Many of these 

applications operate in error tolerant environments, 

where minor inaccuracies can be tolerated without 

significant degradation in output quality. This has led 

to the widespread adoption of approximate 

computing techniques that optimize power and 

performance by sacrificing accuracy within 

acceptable limits. Among these techniques, 

approximate arithmetic circuits, particularly adders, 

play a critical role in striking a balance between 

accuracy, power consumption, and latency. This 

adaptability allows devices to save energy and 

improve speed while still being capable of producing 

precise results when necessary. The ACA adder also 

includes mechanisms to detect and correct errors 

when they occur, making it a practical and efficient 

solution for modern electronics. In situations where 

rapid calculations are required, the ACA adder can 

increase its processing speed, delivering high-

performance outputs in real time. 

 

2-LITERATURE SURVEY 

Evolution of Approximate Adders  
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Early research in approximate adders focused on 

reducing carry propagation delay and power 

consumption by simplifying the carry chain and 

truncating less significant bits. Lu’s Adder, 

introduced in 2004, significantly reduced delay by 

speculatively predicting the carry chain but suffered 

from high error rates due to incorrect predictions. 

Later, Error-Tolerant Adders [ETA], such as ETAI 

and ETAII, segmented the adder into accurate and 

inaccurate regions to improve speed and reduce 

power consumption. However, they lacked 

adaptability and produced high error rates in certain 

scenarios.  

To overcome these limitations, researchers 

introduced Enhanced Truncated Adders (ETAIM) 

that reduced the error rate by modifying the carry 

propagation path but lacked runtime configurability. 

In 2008, Variable Latency Speculative Adders 

(VLSA) employed a speculative approach that 

allowed faster addition while incorporating error 

detection and correction (EDC) to ensure accurate 

results in critical applications.Around the same time, 

probabilistic CMOS (PCMOS) adders leveraged 

probabilistic circuits to reduce energy consumption, 

but they were less reliable under varying workloads.  

Recent Developments in Configurable 

Approximate Adders 

Between 2015 and 2024, significant progress was 

made in enhancing approximate adders by 

introducing runtime configurability and error 

detection mechanisms. Energy-aware approximate 

arithmetic circuits proposed in 2015 combined 

truncation and speculation to dynamically adjust the 

accuracy of operations, achieving a balance between 

power consumption and computational efficiency. 

Accuracy-Aware Approximate Adders (AAA), 

introduced in 2016, enabled runtime accuracy 

adjustment but incurred higher area and delay 

overhead.  

The Reconfigurable Approximate Adder (RAA), 

proposed in 2018, improved configurability but 

lacked a robust error correction mechanism, which 

resulted in occasional inaccuracies during critical 

operations.  

In 2020, the Dynamic Accuracy Configurable Adder 

(DACA) integrated error detection and correction 

(EDC) to improve accuracy configurability but 

introduced additional area and power overheads. 

Low-Power Configurable Approximate Adders in 

2018 and Dynamically Adaptive Approximate 

Computing Techniques in 2021 further optimized 

accuracy configurability while addressing power and 

performance trade-offs. However, these designs still 

struggled to provide a seamless transition between 

approximate and accurate modes in real time 

applications. 

 

3-ANALYSIS AND DESIGN 

PROPOSED METHOD  

Proposed ACA Adder Implementation:  

The proposed ACA (Accuracy-Configurable 

Approximate) adder is designed to provide a balance 

between high performance, low power consumption, 

and configurable accuracy. Unlike traditional 

approximate adders that primarily focus on error-

tolerant applications, this implementation introduces 

an enhanced error detection and correction 

mechanism that dynamically switches between 

approximate and accurate modes, ensuring reliability 

when needed. This design leverages the advantages 

of reduced critical-path delay by cutting the carry 

propagation path, which enhances the adder’s 

operating frequency.  

Architecture Overview and Sub-Adder Partitioning:  
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The 16-bit input vectors A [15:0] and B [15:0] are 

partitioned into three distinct sub-blocks: AL (Low 

Block): Bits [7:0] are handled by the lower sub-

adder. AM (Middle Block): Bits [11:4] are processed 

by the middle sub-adder. AH (High Block): Bits 

[15:8] are managed by the upper sub-adder. Each of 

these 8-bit sub-adders computes partial sums 

independently, and carry propagation between sub-

adders is intentionally limited. By cutting the carry 

chain at sub-adder boundaries, critical path delay is 

significantly reduced, enabling higher operating 

frequency or lower voltage operation for power 

efficiency.  

 

  3.1 Proposed ACA Adder  

  

Approximate Mode for Fast and Low-Power 

Operation 

In approximate mode (when mode = 0), carry 

propagation between sub-adders is ignored beyond 

the critical path. The partial sum results from the 

three sub-adders are concatenated directly to produce 

the approximate sum. This mode allows for high-

speed operation by minimizing delay and power 

consumption, making it suitable for error-tolerant 

applications. The output sum is given by  

SUM  {AH+BH, AM + BM [3:0], AL+BL}  

Accurate Mode with Error Correction Capability 

In accurate mode (when mode = 1), error detection 

and correction mechanisms are enabled to ensure 

precision. Errors are identified by analyzing the carry 

propagation results from the lower and middle sub-

adders. If an error is detected (such as when carry 

mismatches occur), corrective logic dynamically 

adjusts the results of the higher sub-adders. The 

corrected sum is obtained as  

SUMcorrected = {AH + BH + errorAH, AM + BM + 

errorAM, AL + BL}  

This mode ensures that the adder behaves like a 

conventional, accurate adder when needed, 

maintaining high precision for critical computations 

[12]. A key innovation in this implementation is the 

optimized middle sub-adder (AM + BM), which 

mitigates high carry-bit error conditions. In earlier 

designs like ETAII, errors occurred with a 50.1% 

probability. However, by introducing the  SUM_M 

sub-adder, the error rate is reduced to less than 5% 

for random input patterns. This improvement 

dramatically enhances accuracy while maintaining 

high-speed performance.  
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Error Detection and Correction Mechanism 

Error Detection and Correction (EDC) in 

Approximate Carry Adders (ACA) ensures that 

errors introduced by approximate logic in sub-adder 

partitions are corrected for high-accuracy results. 

ACA reduces carry propagation delay by partitioning 

the adder into smaller sub-adders, but the carry 

propagation errors occurring at the boundaries are 

corrected using incrementor circuits and logic gates 

like AND and OR gates. The EDC mechanism in the 

ACA adder consists of three major components: 

Error Detection Logic: Monitors carry propagation 

errors using AND and OR gates. Incrementor for 

Error Correction: Corrects errors by adding a 

correction factor. The multiplexer for result selection  

selects between the approximate sum and the 

corrected sum. Sum and Carry Generation by ACA 

Adder: The ACA adder partitions the input operands 

AAA and BBB into multiple sub-adders that 

independently compute the sum and carry for each 

segment. For an nnn-bit adder, if it is partitioned into 

mmm sub-adders 

4-SOFTWARE REQUIREMENTS 

 XILINX VIVADO 

Here are the steps to download Xilinx Vivado:  

The installation process for Xilinx Vivado 2022.2 

was carried out following the official guidelines.  

Note: A complete set of tutorials and guides 

regarding the installation and licensing of Vivado 

can be found at the following URL: Vivado 2022.2 - 

Installation and Licensing (xilinx.com)  To install it, 

go to: Downloads (xilinx.com)   

Download the Windows self-extracting Web Installer 

  

  

Windows Self Extracting Web Installer  

When you click on it, it will ask you to create a Xilinx 

student account. Do this by using your school email 

and a password. You simply have to put in your 

address, etc. Since you are going to download the 

free version of Vivado, this step is just a formality, 

but it is necessary.  

When you log in to Xilinx with the credentials you 

just created, it will give you a Download button. 

Click that to download the Web Installer.  

Once the Web installer is downloaded, run this EXE 

file by double-clicking on it; it should be under the 

“Downloads” directory.  This download will not take 

too long (a minute or so), since the Web installer is 

only bout 00 MB. However, when you double-click 

on the web installer, the actual Vivado install will 

start, and it generally takes hours! It is around 75GB.   

                                        

5-IMPLEMENTATION 

5.1 Step 1: Project Creation 
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1. Open Vivado:  

2. Launch the Vivado Design Suite.  

3. Create a New Project:  

4. Select "Create New Project" → Click Next.  

5. Enter the project name and location.  

6. Choose RTL Project → Check Do not specify 

sources at this time.  → Click Next.  

7. Select your FPGA device (e.g., Artix-7 or Zynq-

7000 series)  

5.2 Step 2: Design Implementation 

1. Write the ACA Adder Design  

2. Add Source File:  

3. Go to Flow Navigator → Add Sources → Add or 

Create Design Sources. 4. Create a Verilog source 

file (e.g., aca_adder)  

 5.3 Step 3: Write Testbench 

1. Add a Testbench File:  

5.4 Step 4: Add Constraints (XDC File) 

1. Create an XDC File:  

 Go to Flow Navigator → Add Constraints → Create 

Constraint File.  

Name it aca_adder.xdc  

5. 5 Step 5: Simulate the Design:  

1. Go to the Simulation tab in Vivado.  

2. Select the testbench as the top module.  

3. Run the simulation. View the results in the 

waveform viewer.  

4. Verify the output sum and error for different 

modes.  

5. 6 Step 6: Synthesis and Implementation 

1. Run Synthesis: Click on Run Synthesis in the 

Flow Navigator.  

2. Analyze Reports: Check the synthesized design 

for area, timing, and logic utilization.  

3. Run Implementation: Click on Run 

Implementation to optimize routing and ensure 

timing closure.  

 

6-RESULTS AND DISCUSSIONS 

6.1 Experimental setup  

The proposed Accuracy-Configurable Approximate 

(ACA) adder was designed and implemented using 

Xilinx Vivado to validate its performance and 

efficiency. The Verilog code for the ACA adder was 

synthesized and simulated using the Vivado design 

suite, allowing for a detailed analysis of its 

functionality in both approximate and accurate 

modes. A comprehensive test bench was developed 

to simulate multiple input patterns and dynamically 

switch between modes. This test bench was designed 

with three primary objectives: verifying the 

correctness of the adder in accurate mode by 

comparing its output with that of a conventional 

adder, evaluating the error rate to validate the 

functionality in approximate mode, and measuring 

the pass rate to quantify correctness in both modes.  

ACA adder was tested with 1,000 random input 

patterns, achieving a pass rate of 97.70%, with 977 

correct results, demonstrating its high reliability 

under varying conditions.  

Furthermore, the Peak Signal-to-Noise Ratio (PSNR) 

was recorded at 33.13 dB and the Structural 

Similarity Index (SSIM) was 0.8611 in approximate 

mode, while in accurate mode, the PSNR and SSIM 

improved to 39.90 dB and 0.9663, respectively, 

highlighting the high fidelity of the error correction 

mechanism and superior output quality of the adder.  

6.2 Comparison  

We assess the performance of each adder by 

analyzing the pass rate and the accuracy metrics 

(ACCamp and ACCinf) that we have proposed. 

Gate-level simulations are conducted across a range 
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of clock periods to compare five different adders: 

CLA (Carry Look-Ahead Adder), Lu’s Adder, ETAI 

(ErrorTolerant Adder Type I), ETAIIM (Modified 

Error-Tolerant Adder Type II), and the proposed 

ACA (Approximate Carry Adder) without error 

correction.  

To ensure a fair comparison, we maintain a uniform 

carry-chain width of 8 bits across all four 

approximate adders. Additionally, a register 

(flipflop) is placed at each output port to capture and 

detect timing errors effectively, allowing us to 

evaluate the reliability of each adder under different 

operating conditions.  

The collected data helps in identifying trade-offs 

between accuracy, speed, and energy efficiency, 

which are critical in designing energyefficient and 

high-performance arithmetic circuits.  

                                    

Table 6.1. Comparison with different adders  

Note: ACA-Accuracy configurable adder, ETA-

Error tolerant adder, HEAA-High efficiency 

approximate adder, LOA-lower part OR adder, 

VOS—variable output speculative adder  

Table 1 shows area, pass rate, accuracy, minimum 

clock period, power, Error rate, frequency and EDC 

overhead for each adder design  

The proposed ACA-I Adder has the smallest area 

(923 µm²) among the compared adders, making it 

more area-efficient than ETA-II (1280 µm²), HEAA 

Parameter  ACA  ETA-II  HEAA  LOA  VOS  

Area (µm²)  923  1280  1100  1050  1150  

Total power (W)  0.117  0.135  0.129  0.122  0.140  

Static power (W)  0.011  0.020  0.016  0.013  0.018  

Dynamic 

 Power (W)  

0.106  0.115  0.113  0.109  0.122  

Clock period (ps)  200  250  220  240  260  

Max  frequency 

(GHZ)  

5.00  4.00  4.55  4.17  3.85  

Pass rate) (%)  97.70  95.20  96.80  96.10  95.00  

ACCamp  

(Accuracy  -  

Approx. Mode)  

0.997  0.993  0.994  0.995  0.991  

ACCinf  

(Accuracy-Inf.  

Mode)  

0.993  0.988  0.990  0.991  0.987  

Error Rate (%)  2.30  4.80  3.20  3.90  5.00  

Error  Correction 

Overhead (%)  

28  75  65  58  70  
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(1100 µm²), LOA (1050 µm²), and VOS (1150 µm²). 

This is a significant advantage for resource-

constrained applications. In terms of power 

consumption, the ACA-I Adder has the lowest total 

power (0.117 W) and dynamic power (0.011 W) 

compared to the other adders. The static power 

(0.106 W) is slightly higher than LOA (0.109 W) but 

lower than ETA-II (0.115 W), HEAA (0.113 W), and 

VOS (0.122 W). This makes the ACA-I Adder highly 

power-efficient, especially for energy-constrained 

applications like IoT devices and neural network 

accelerators. The ACA-I Adder has the lowest clock 

period (200 ps) and the highest maximum frequency 

(5.00 GHz) among the compared adders. This is a 

significant improvement over ETA-II (4.00 GHz), 

HEAA (4.55 GHz), LOA (4.17 GHz), and VOS (3.85 

GHz). The low latency of the ACA-I Adder makes it 

highly suitable for high-performance applications 

where speed is critical, such as real-time signal 

processing and multimedia applications.   

The ACA Adder achieves the highest pass rate 

(97.70%), outperforming ETA-II (95.20%), HEAA 

(96.80%), LOA (96.10%), and VOS (95.00%). This 

indicates that the ACA Adder is more reliable in 

producing correct results. In terms of accuracy 

metrics, the ACA Adder achieves ACCamp = 0.997 

and ACCinf = 0.993, which are comparable to LOA 

(ACCamp = 0.995, ACCinf = 0.991) and higher than 

ETA-II (ACCamp = 0.993, ACCinf = 0.988), HEAA 

(ACCamp = 0.994, ACCinf = 0.990), and VOS 

(ACCamp = 0.991, ACCinf = 0.987). These high 

accuracy metrics make the ACA Adder suitable for 

applications requiring high reliability, such as 

multimedia processing and error-tolerant systems. 

Compared to the latest approximate adders, the ACA 

Adder offers a unique combination of runtime 

configurability, high accuracy, and low latency. 

While other designs like ETA-II and LOA focus on 

power reduction, they lack the flexibility of runtime 

configurability . Similarly, designs like HEAA and 

VOS achieve high accuracy but do not offer the same 

level of performance and configurability as the ACA 

Adder.  

6.3 Validating with Gaussian Smoothing  

To further validate the design, Gaussian smoothing 

was used in MATLAB to compare the performance 

of the ACA adder for image processing applications. 

The validation process involved extracting noisy 

pixel values from a test image and using these values 

as inputs to the ACA adder’s test bench in Vivado. 

The simulated outputs were stored in .hex format and 

imported into MATLAB, where the results were 

compared with the expected outputs from the 

Gaussian smoothing algorithm. This process enabled 

a thorough analysis of the error rate and accuracy of 

the ACA adder in image processing applications. The 

validation results demonstrated a 98% accuracy rate 

with high PSNR and SSIM values in both modes, 

confirming that the ACA adder effectively 

maintained high image quality while performing 

approximate computation. The close match between 

Vivado-generated results and MATLAB simulations 

reinforced the robustness of the ACA adder in 

maintaining accuracy even when used in complex 

image processing applications.  

The ACA adder achieves a PSNR of 33.13 dB and 

SSIM of 0.8611 in approximate mode and a PSNR of 

39.90 dB and SSIM of 0.9663 in accurate mode. The 

findings indicate that our proposed adder can be 

effectively utilized in image processing and filtering 

applications, offering substantial power savings with 

only a minimal degradation in image quality. The 

results also show that the ACA Adder can achieve 

significant power savings while maintaining high 
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accuracy. For example, in approximate mode, the 

ACA adder achieves a PSNR of 33.13 dB and SSIM 

of 0.8611, while in accurate mode, it achieves a 

PSNR of 39.90 dB and SSIM of 0.9663. These values 

are comparable to or better than those achieved by 

other approximate adders, such as the Error-Tolerant 

Adder (ETA) and Lower-Part OR Adder (LOA), 

which typically achieve lower PSNR and SSIM 

values . This suggests that the ACA adder is well-

suited for applications where both power efficiency 

and high accuracy are required, such as multimedia 

processing, real-time video processing, and edge-AI 

applications.  

Adder Type  PSNR  

(Approx.  

Mode, dB)  

  

SSIM  

(Approx.  

Mode)  

PSNR  

(Accurate  

Mode, dB)  

SSIM  

(Accurate  

Mode)  

Proposed  ACA  

Adder  

33.13  0.8611  39.90  0.9663  

Error-Tolerant  

Adder (ETA)  

30.92  0.845  38.20  0.957  

Lower-Part  OR  

Adder (LOA)  

31.70  0.845  38.20  0.957  

Approximate Mirror  

Adder (AMA)  

30.85  0.810  36.90  0.940  

Generic Accuracy 

Configurable Adder  

(GACA)  

32.10  0.850  38.80  0.960  

High-Efficiency  

Approximate Adder  

(HEAA)  

31.50  0.835  37.80  0.950  

Variable Output 

Speculative Adder 

(VOS)  

30.75 0.815 36.85 0.938 

Table 6.2 comparison of PSNR and SSIM with each adder  

 

Table 3 shows that the proposed ACA Adder performs better than other approximate adders, including HEAA, 

VOS, and LOA, in terms of both PSNR and SSIM in both approximate and accurate modes.  
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(a) original image  

 

 

smoothed, (d) difference approximate, (e) difference 

accurate, (f) reference smoothed  

 

 

 

 It shows different images of Gaussian smoothing 

performed, validating with the ACA adder that 

provides the  

effectiveness of the ACA adder in maintaining high 

image quality in both approximate and accurate 

modes. The Approximate Smoothed image shows 

minimal visual degradation compared to the 

Accurate Smoothed image, and the difference 

images highlight the small errors introduced by the 

ACA adder in both modes. The Reference Smoothed 

(MATLAB) image serves as a benchmark, 

confirming that the ACA adder produces results 

close to the ideal output.  

This makes it highly suitable for applications where 

maintaining High image quality is critical, such as in 

multimedia processing, real-time video processing, 

and edgeAI applications. The visual results illustrate 

the effects of Gaussian smoothing applied to a 

sample image, using both approximate and accurate 

computational approaches implemented via the ACA 

(Adaptive Configurable Approximate) adder. This 

comparative analysis demonstrates the effectiveness 

of the ACA adder in preserving image quality across 

different precision modes. Specifically, the 

Approximate Smoothed image—generated using 

the ACA adder in its approximate mode—exhibits 

minimal perceptual degradation when compared 

to the Accurate Smoothed image, which utilizes the 

ACA adder operating in full precision. 

To further highlight the impact of approximation, 

difference images are presented. These images 

capture the pixel-wise discrepancies between the 

reference and smoothed outputs, making the minor 

errors introduced by the ACA adder visually 

quantifiable. Notably, these differences are limited 

in magnitude and spatial extent, indicating that the 

ACA adder introduces only insignificant 

distortions that are generally imperceptible to the 

human eye. 

For benchmarking purposes, a Reference Smoothed 

image is generated using MATLAB’s high-precision 
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built-in functions, serving as an ideal output 

standard. A visual and quantitative comparison 

between the reference and the ACA adder results 

reveals a high degree of similarity, thereby 

confirming the ACA adder’s capability to closely 

approximate accurate Gaussian smoothing behavior, 

even in reduced-complexity or energy-efficient 

configurations. 

 

7-CONCLUSION 

The Accuracy-Configurable Approximate (ACA) 

Adder represents a transformative approach to 

designing energy-efficient and high-performance 

arithmetic units for modern computing systems. By 

introducing runtime configurability, the ACA 

Adder dynamically adapts to varying precision 

requirements, enabling seamless transitions between 

approximate and accurate computation modes. This 

flexibility allows the adder to deliver high-quality 

results in approximate mode while ensuring full 

precision in critical computations. One of the key 

strengths of the ACA Adder lies in its ability to 

achieve significant energy savings without 

compromising performance. Experimental 

validation using Gaussian Smoothing demonstrates 

the ACA Adder's exceptional performance across 

different modes. In approximate mode, the adder 

achieves a Peak Signal-to-Noise Ratio (PSNR) of 

33.13 dB and a Structural Similarity Index (SSIM) 

of 0.8611, indicating that it delivers acceptable 

results with reduced computational resources. In 

accurate mode, the ACA Adder excels with a PSNR 

of 39.90 dB and an SSIM of 0.9663, ensuring the 

highest level of precision for critical operations. 

These results highlight the adder's ability to balance 

energy efficiency with accuracy, making it suitable 

for real-time applications where both performance 

and precision are vital. 

In terms of power efficiency, the ACA Adder 

demonstrates impressive savings, achieving up to 

37% power reduction compared to conventional 

adders. Additionally, it offers a 24.6% 

improvement in throughput, further boosting 

system performance while reducing overall energy 

consumption. These figures underline the ACA 

Adder's capability to optimize power consumption in 

energy-constrained environments, such as mobile 

devices or IoT systems, without sacrificing the 

quality of results.Looking ahead, the ACA Adder 

sets a new benchmark for energy-efficient 

arithmetic designs, paving the way for smarter, 

more sustainable hardware in emerging technologies. 

Its innovative architecture, which integrates 

parameterized sub-adders and an error detection 

and correction mechanism, ensures robust 

performance across diverse workloads. The ability to 

dynamically adjust precision enables the ACA Adder 

to offer significant trade-offs between performance, 

power efficiency, and accuracy, making it an ideal 

solution for a variety of modern applications, 

including autonomous systems, machine learning 

accelerators, and real-time data analytics. 
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